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Guide to the Trial Edition

Thank you for downloading the Trial Version of Enterprise
Architect and taking this time to become acquainted with
what the tool suite has to offer. We hope this short guide
will prove helpful in showing you how to get started and
understand some of the crucial modeling concepts
underlying the tool.

Over the next 30 days you will have the opportunity to test
drive Enterprise Architect 1n all its different editions and
find out for yourself how it can help visualize, examine,
verify and enhance your understanding of complex solution
domains across the Business, Software, Systems and
Architecture areas.

This guide 1s intended to supplement and support your
initial contact with Enterprise Architect, and covers the
more important concepts and behaviors that are critical to
getting the most out of the tool.

Here 1s an overview of the guide and its intended purpose:

e Part | 1s a brief introduction to some important concepts
concerning the tool, its repository based modeling and the
general function of the user interface

e Part 2 will step you through starting up Enterprise
Architect, finding the most common and necessary
controls and windows, and learning how to customize the
user interface

e Part 3 will walk through creating a new model, setting a
Perspective and using pattern-based model fragments to
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fast track model construction

e Part 4 1s a collection of 'where to next' suggested links to
other material that will enhance and enrich your Trial
experience, depending on your personal requirements

Please take the time to read through this document if you are
a newcomer to Enterprise Architect, as it covers some of the
most fundamental concepts and tools you will be using
during this Trial period. Enterprise Architect 1s an incredibly
rich and extremely powerful modeling and design tool that
implements many technologies, frameworks and tools.
Walking through this guide will help you find the right tools
and right modeling language(s) for your needs.

Thanks once again for taking the time to try out Enterprise
Architect. If you have any problems with installation or
getting started, please contact Sparx Systems Trial support
team, at trial-assist@sparxsystems.com.
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Part 1 - Concepts

More than a Drawing Tool

One of the most important concepts underlying Enterprise
Architect is that 1t is far more than a simple drawing tool.
Unlike many of the simple drawing tools that sometimes
present themselves as modeling tools, in Enterprise
Architect all models are stored in and built on very detailed
and rich repositories. Some important results of this
approach are:

. A diagram in Enterprise Architect is a view of some part
of the underlying model

. Model elements can appear in multiple diagrams

. Updating an element in one diagram will update it in all
other diagrams it appears in

. Connections between elements are first level model
elements, not just visual representations

. The Project Browser (a UI window you will learn about
later) 1s the doorway into the model itself

. The Diagram Toolbox has a palette of appropriate
elements for the current diagram type and modeling
language

. Elements from modeling languages have special
properties, characteristics and linkage restrictions
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Repository Based Modeling

A model Repository in Enterprise Architect can be
implemented 1n a number of ways, depending on need.
Regardless of the type it is important to note that you must
create or open a repository before you can do any modeling.

Some typical repository types include:

e A single file (.eap/.eapx/.fdb/.feap) which 1s typically
used by a single developer

e A DBMS (Oracle, SQL Server, MySQL ...) based
repository used by workgroups and larger teams

e An internal LAN based Sparx Cloud-Server repository
(with .FDB or DBMS back end) for simplified
deployment, efficiency and other benefits

e A web facing Sparx Cloud-Server repository for globally
distributed development, stakeholder access, optimization
and more

The kind of modeling you will do usually determines the
kind of repository you will need. For the purposes of your
Trial, the single file approach will be the easiest to start
with, unless you have access to some pre-existing larger
repositories. This guide will assume a single file as the
simplest solution to get started with. But remember, your
single file model can always be scaled up later into a full
DBMS or Cloud based repository if required!
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Technologies, Perspectives & Frameworks

Another term you will come across a lot in learning about
Enterprise Architect 1s "Technology'. In this special case,
what is meant is a collection of domain-related modeling
clements that together form a unique modeling language.
For example, UML 2.5 1s an open standard modeling
language supported by Enterprise Architect; it is commonly
referred to as the 'UML Technology' or 'UML Perspective'.

Technologies

. A Technology 1s a collection of related modeling elements
forming a modeling language

. A Technology in Enterprise Architect can also include
scripts, shapes, document templates, patterns and other
useful artifacts

. Technologies can be turned on and off as required in a
model repository

Patterns

. Patterns are collections of re-usable modeled content, for
example a basic Use Case Model or simple Class Model

. Patterns are used to kick start modeling and speed up the
creation of common modeling solutions

. Enterprise Architect 14 includes a collection of over 1000
patterns with detailed explanations, in many different
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modeling languages

Perspectives

. A Perspective 1s a constraint placed upon the user
interface to only show a particular technology or set of
technologies

. A Perspective 1s used to reduce complexity and help you
focus on your task

Frameworks

. A Framework is a collection of patterns, modeling
languages and other material that together support a
modeling approach

. Frameworks can aggregate different modeling languages
and often help determine model structure

As you work through your 30 day Trial, you will become
very familiar with these terms and see how each contributes
to your modeling expressiveness and effectiveness.

Things you can do with a Model

Because an Enterprise Architect model is repository based
with a rich set of connections, meta-information and other
material supporting the visual aspect, it 1s possible to take
the model and create a wide range of new material from the
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model itself. Some possibilities include:

. Documents in rich text or PDF format that expose
underlying aspects of the model as well as the visual
representations

. Code generation from Class models and from behavioral
models

. Model interchange material in XMI and other formats so
that your model can be read and acted on by other tools

. Simulations of behavioral models in a variety of formats
such as BPSim, DMN, State Models, Activity Graphs and
more

. SysML Parametric simulation with Open Modelica
. Conduct reviews of model content

. Make models accessible online with WebEA and
ProCloud Server

Once you move your model in a DBMS or Cloud based
repository you might also implement model security to
control who can modify the model and control locking on
individual elements. In the Ultimate Edition you might also
implement Row Level Security and control which users can
see what parts of the model.

For the ambitious it is also possible to access the underlying
model using the automation (Active-X) interface of
Enterprise Architect using scripts and plug-ins, or if
accessing a Sparx Pro-Cloud Server, via the OSLC interface
- a RESTful API for exploring and modifying the model
using standard web based calls.
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Next Step

Having installed the Enterprise Architect Trial Edition, you
can now start it up and explore it. You can refer to one of
two guides, depending on whether you have downloaded the
Trial Edition for release 14.0 or for release 14.1:

. Part 2.0 - First Contact 14.0 or
. Part 2.0 - First Contact 14.1
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Part 2 - First Contact 14.0

Starting Enterprise Architect

We hope you are now familiar with the concepts presented
in Part 1 of this Guide. It's now time to start up Enterprise
Architect and find your way around the user interface.
Along the way you will make a few choices to help tailor
the Trial edition to your purpose. Note that any decisions
you make are not final and can be changed by restarting
Enterprise Architect or using the various preference tools to
customize your experience.

Assuming you have installed Enterprise Architect you can
now click on the desktop icon (if available) or find the
shortcut in the Start Menu if preferred. Presuming
everything is in place we are now on our way.

Some House-keeping

During the process of opening the Trial, two dialogs will
pop up.

The first dialog confirms that you have started using the
Trial edition for the 30-day trial period, and provides an
option for accessing the web site to purchase the product.
Also included are some links to useful material on the web
to help you with more advanced questions.
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Evaluation Version of Enterprise Architect
Thank yaou faor trying Entemprise Architect . Purchase Entemprise Architect now
four 30 day tral begins now for a full year of support and updates

from Spanc Systems

X

=

Continue Trial Buy Mow

Meed help getting started? Take some time to look at the video demonstrations
and tutorials on the Spanc Systems resource page.

Demonstration Tutorials Sparx systems Community

Resources EA Reviewer's Guide Additional Extensions

WA, Spa F:(S].-'St Ems.com

This dialog shows a count-down of the days left in the Trial
period.

Click on the Continue Trial button; the second dialog now
displays, prompting you to select the edition of Enterprise
Architect that you want to try out. Information about what
cach of the different editions includes and does is available
at sparxsystems.com.

This dialog will display whenever you open the Trial
version, so you can explore and compare different editions
as many times as necessary within your trial period.
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Select Trial Version

@ ENTERPRISE

Choose Trial Edition To Open

To help you determine the edition best suited to your needs, you can open
this trial product in any corfiguration.

i) Professional

Compare Editions

QK Cancel Help

Click on the radio button for any edition (for the purposes of
this topic, it does not matter which) and click on the OK

button.

The main Enterprise Architect workspace displays.
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@Start Page x

This is initially overlaid by the 'Application Look' dialog.
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Application Look

Theme Dark Gray

Accent Color: Blue (Default)

Visual Appearance
Code Editor: Automatic
Diagram: Use current theme @
Workspace L

Default Note Zoom:

Window Styles

B show Menu Icons

Main View Tabs use Caption style

Main View Tabs at bottom (restart)
Property Sheets use Tree style

B Use Property List for Elements

B Prefer Property dialogs

M Increase Note Paragraph Spacing

T T T T

You can use this dialog in tailoring your workspace to have
a different appearance; we will show you how in Part 4. For
now, click on the Cancel button.

A screen will then display to highlight the features of
Release 14.0.
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Mo current project - EA - 30 Day Trial

e clte Configure ¢ Find Command

t Code Ex
@ .3 Full Screen % Q & EI @ "\{f 1 My Kanban IE @ Home Page
4 Visual Style ~ bt &1 My Gantt @ Libraries ~
+ Preferences Discussions Reviews Team Mail Calendar My Help .
- Library Journal - & Register
View Collaborate Help
« r X

@ ENTERPRISE

Enterprise Architect 14 is a revolution in intuitive, focused and productive modeling and design. Please
read through this overview for a quick introduction to what is new and noteworthy in this latest releas
Architect from Sparx Systems.

Version 14 Highlights

OStartPage|OtA 14 Overvew ® ¥

All Perspectives

Close this screen (click on the X in the screen tab). You now
see the cleared application workspace.

First Steps

Very (very) important!

When Enterprise Architect starts up there 1s no current
repository selected. Before you can start modeling and
creating diagrams you will need to either open an existing
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model or create a new one. If this is your first time working
with Enterprise Architect and you don't have any existing
models to use, you should create a new file based repository
that you can experiment and play in while you learn about
modeling and using Enterprise Architect.

Let's create a new Repository file now.

Press Ctrl+N which 1s the shortcut key to create a new file
based repository

_Or_
In the 'New' section on the Enterprise Architect Start Page,
click on the 'Create a new project' option
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Mo current project - EA - 30 Day Trial

Construct Simulate Code Execute Configure

L v R

Mew File

L

@Start Page x

Select a filename and location for your repository

You will be prompted to select a file name and location for
your new repository. Once you have chosen a name and
location, click on the OK button - Enterprise Architect will
create a new empty model for you to begin working with.

What has changed?
Although not much will appear to have changed, you now
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have a working repository into which you can start adding
new elements and diagrams. The main thing to note is that
the Project Browser now has a new root element called
'Model' which 1s the starting point from which you will
build your own individual repository.

B » 1 » Model
Project Browser ~ # x
IOt =~

Global  Context

i1 Model

Where are we now?

By now we have started up the Trial version, created a new
repository and loaded that repository into the Enterprise
Architect workspace. Next up we will create some new
model elements and diagrams (in Part 3), before moving on
to a brief overview of the user interface (in Part 4,
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Part 2 - First Contact 14.1

Starting Enterprise Architect

We hope you are now familiar with the concepts presented
in Part 1 of this Guide. It's now time to start up Enterprise
Architect and find your way around the user interface.
Along the way you will make a few choices to help tailor
the Trial edition to your purpose. Note that any decisions
you make are not final and can be changed by restarting
Enterprise Architect or using the various preference tools to
customize your experience.

Assuming you have installed Enterprise Architect you can
now click on the desktop icon (if available) or find the
shortcut in the Start Menu if preferred. Presuming
everything is in place we are now on our way.

Some House-keeping

During the process of opening the Trial, a dialog will pop
up.
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Evaluation Version of Enterprise Architect £
To help you determine the edition best suited to your needs, you can open
this trial product in any configuration.
_! Professional
-/ Corporate Compare Editions
2 Unified
Oiltimatei Help
Thank you for trying Enterprise Architect.
You have 12 days left of your evaluation.
ﬂﬂtﬂ"
4 '.:'._f..--"’:
Pricing [ Continue Trial

This dialog confirms that you have started using the Trial
edition for the 30-day trial period, and provides an option
for accessing the web site to review pricing and purchase
options for the product. Also displayed is set of radio
buttons from which you select the edition of Enterprise
Architect that you want to try out. Information about what
each of the different editions includes and does is available
from the website by clicking on the Compare Editions
button.

This dialog will display whenever you open the Trial
version, so you can explore and compare different editions
as many times as necessary within your trial period.
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As shown, the dialog also displays a count-down of the days
left in your Trial period.

Click on the radio button for any edition (for the purposes of
this topic, it does not matter which) and click on the
Continue Trial button; the main Enterprise Architect
Workspace displays.

Visual Style -

Pm]ect Browser - # x
meHt | =-
Global  Contex

b Common Relationships
" <dlick to open project...> b A Recent -
repository

You can tailor this workspace to have a different layout,
content and appearance to support your work tasks; we will
show you how 1n a later topic

First Steps
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Very (very) important!

When Enterprise Architect starts up there is no current
repository selected. Before you can start modeling and
creating diagrams you will need to either open an existing
model or create a new one. If this is your first time working
with Enterprise Architect and you don't have any existing
models to use, you should create a new file based repository
that you can experiment and play in while you learn about
modeling and using Enterprise Architect.

Let's create a new Repository file now.

Press Ctrl+N which 1s the hot key to create a new file based
repository
_OI‘_

In the 'New' section on the Enterprise Architect Start Page,
click on the 'Create a new project' option
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New

Create a new local repository

Create a new project

k

Manage projects...

@Start Page x

Select a filename and location for your repository

You will be prompted to select a file name and location for
your new repository. Once you have chosen a name and
location, click on the OK button and Enterprise Architect
will create a new empty model for you to begin working
with.

What has changed?

Although not much will appear to have changed, you now
have a working repository into which you can start adding
new elements and diagrams. The main thing to note is that
the Project Browser now has a new root element called
'Model' which is the starting point from which you will
build your own individual repository.
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200 ) ¢ 7 v Model

Project Browser ~ #* x
Ot ¥ =-

Global Context

i) Model

Where are we now?

By now we have started up the Trial version, created a new
repository and loaded that repository into the Enterprise
Architect workspace. Next up we will create some new
model elements and diagrams, before moving on to a brief
overview of the user interface.
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Part 3 - Building a Model

First Steps

Now that we have a new model created and loaded into the
workspace (from Part 2), our new goal 1s to add some
content to the model.

There are many ways to add content, but for this first
example we will take a convenient shortcut and add model
content using a model pattern. To do this you will:

. Select an appropriate Perspective

. Select a model pattern

. Familiarize yourself with the pattern content
. Add the pattern content to your repository

. Find the new content in the Project Browser and explore
any new diagrams

So let's get started ...

Selecting a Perspective

As we mentioned earlier, a Perspective is a constraint placed
on the workspace to only show a limited set of
Technologies. We can select a Perspective in a number of
ways, but for this walk through we will use the drop menu
in the top right of the user interface. Our goal will be to
create a simple Use Case model that we can later extend and
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customize.

Once you have found the Perspective menu, click on it and
select 'UML | All UML' as shown here.

- 0O X

-

® Perspective

A1l UML uML

b Structural Strategy

Behavioral Analysis
Requirements

Find Pacl D

Business Modeling

-

Software Engineering
Systems Engineearing
Database Engineering
Enterprise Architecture
Information Exchange

Construction

- T v w w v w ¥ v w v w v

Management

-

My Perspectives
My Ribbon Sets r

Manage »

Element Propertie5| MNaotes

Using a Pattern

Doing this will cause the Model Wizard to appear in the
central design area, pre-set to show all the UML Model
Patterns (and there are quite a few!) Scroll down until you
find the 'Use Case' section and select the 'Basic Use Case
Model'. You should now be looking at something
resembling this image:
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All UML Perspective
Component Interfaces with | SON Payload .
P Basic Use Case Model

Starter Deployment Diagram
Basic Deployment Diagram with Node Instan

Basic Deployment Diagram with Composition The Basic Use Case Model pattern creates elements and a Use Case diagram that describes the goals that user roles
Basic Deployment Diagram with Attributes wish to achieve from the system. The Use Cases are all contained within the System Boundary and the Actors all lie
Node Instance with Nested Deployment outside the Boundary.

Node Instance with Deploy Dependency
Single Device with Execution Environment
Database Server with Deployed Database
Node with Component and Artifact Instances
Network Device Types

4 Use Case Diagrams
Starter Use Case Model

Basic Use Case Model with Include

Basic Use Case Model with System Actor
Basic Use Case Model with Extend

Basic Use Case Model with Generalization
Basic Use Case Model with Collaboration
Basic Use Case Model with Test Cases
Structured Use Case Model

Type Legend
Use Case Model with Activity Diagram ype Legens
Use Case Model with State Machine Diagram [ Acter
~J [[] usecase
4 Sequence Diagrams o
ary

Starter Sequence Diagram
[=] Basic Sequence Diagram
[=] Basic Sequence Diagram
[=] Basic Sequence Diagram
[=] Basic Sequence Diagram
[=] Basic Sequence Diagram
[=] Basic Sequence Diagram
Sequen
Sequen

with Reply Message — include
— Extend

with Synchronous
with Asynchronous
with Alternative Fr.

Figure 1. Shows a Use Case diagram with Actors and a number of Use Cases enclosed in a System Boundary. One Actar
with Loop Fragment represents a system and is displayed using rectangular notation.
with Boundary Co

onent Classifiers

onent Instances Discussion

[=] Basic Sequence Diagram with Lost Message

Basic Sequence Diagram with Found Messa The purpose is to allow Business Analysts and other stakeholders to describe the value that Actors (the roles that
Sequence with Object Creation and Destruc. users play) want to achieve when interacting with the system.
Sequence with Component Ports and Interf

4 Communication Diagrams

Starter Communication Diagram The pattern is typically used in the analysis phase of an initiative and can be used to realize any number of
Communication Diagrams wi ith Business Obj. Requirements and as a way of providing specification for the implementation team.
= —— )

Create Pattern(s) Add To: l:|ﬂ M Customize Pattern on import M Combine with selected Package

Note that the right hand side has some very useful
information about the pattern, including an 1image to show
what you will get, a discussion of when you should use this
pattern, additional references and other material. While
some of the terms and references might be unfamiliar at this
stage, 1t would be a good idea to do a quick read through to
become familiar with what we are adding to the new model.

When you have finished reading, click on the Create
Pattern(s) button located in the lower left corner of the
Model Wizard. Enterprise Architect will now create new
model elements, diagrams and Packages as required to make
a copy of this pattern for you to customize and play with.
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Lets look at the Project Browser

Ok, now that we have created our first model content, let's
take a look at what we have added. To do this, take a look at
the Project Browser.

eo b [ F Model » Basic Use Case Model

Project Browser ~ * x| Toolbc

F1ICOTR I+ + | =- Search
F Use Ca
4 ol Model ' Commi
4 [T]Basic Use Case Model [ Commi
EgEasic Use Case Model | I+ Artifac
[+ [ Actors

[+ [ Use Cases

As you can see from this image, there 1s new content that
has been added to the model. This includes a top level
Package and diagram, and some Actors and Use cases
(within the 'Actors' and 'Use Cases' Packages). Let's take a
look at this 1n detail.

Double-click on the 'Basic Use Case Model' diagram link to
show the graphical view of what we have. You should see
this diagram:
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<« 28 Basic Use Case Model. Use Case Diagram € - x

Start Page =Model Wizard |#=Basic Use Case Model x

M modified: 2/07/2018 2.38:07 PM 100% 827x 1163 All UML

In this diagram you can see several Actors and Use Cases. If
you click on one of the Actors and then press Alt+G, or
right-click and choose 'Find | In Project Browser' from the
context menu, the 'Actors' Package is expanded and the
clement selected in the diagram will be selected in the
Project Browser, as shown here.

(c) Sparx Systems 2018 Page 31 of 82 Created with Enterprise Architect



Guide to the Trial Edition - Guide to the Trial Edition 21 December, 2018

i E) » / » Model » Basic Use Case Model b Actors
Project Browser ~ # x | Toolbox + 3 x | € %3 Basic Use Case Model Use Case Diagram & v x
5 — - )
Ot 4| =- search O P H
Global  Context 4 Use Case
= Actor System One or Entity One
4 g Model iu i & Z
se Case
4 [T Basic Use Case Model O | | g
4 Bounda
22 Basic Use Case Model & System Actor E
4 FlActors 4 Use Case Relationships —_ Use Case A Use Case D
? Actor A ¥ Use ActorA
% Actor B /' Associate
% Actor C A Generalize
% Actor D A Include
% System Actor E /' Bdend
: —_— Use Casc B S
b [JUse Cases [ —
P Comman Relationships ActorB Actor D

P Artifacts
o
f Xl

Z -
’ A\ E

Z Z
Z Z
7 Actort 7

G

0

K|
@Start Page =Model Wizard |*=Basic Use Case Model x a

Use Case Diagram:Basic Use Case Model. created: 2/07/2018 2:38.07 PM modified: 2/07/2018 2.38.07 PM 100% 827 x 1163

As you can see, there is an underlying model-level element
in the Project Browser that has a graphical representation in
a diagram. Note that you can place a single model element
in as many diagrams as you like, and that changing the name
or notes or other element properties will be reflected
immediately in all diagrams in which the element has been
placed.

Working with Properties

Let's take a closer look at one of the elements and see what
kind of information you can add to describe in detail what a
particular element's purpose and behavior can be.

There are many property windows in Enterprise Architect,
and for this walk-through we will look at a few of the most
important. There are many shortcuts and keystrokes to bring
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up different property sheets, but for now it is simplest to
access them from the main Ribbon:

Start > Explore > Properties button

Design Layout Specialize Publish Construct
s
Ak B S R s
. i
Portals = Browse Trace Search Perspective Workspace Preferences
Show | v  Properties | View
G E) 1+ v Notes [ e Model F Actors
Requirements |]n|bnx - 0L Basic |
Constraints —
tarch e ,':' =
Scenarios
Use Case
y EM - Features % Actor
poe Tagged Values D Use Case
4 [o]BasiclU
Egﬁas Summary Boundary
4 A Linked Document | lUse Case Relationships :
%. Construct YW Use Aork
%ActurE / Associate
%Actnr’c /' Generalize
% ActorD A Include O

The Properties Window

Let's start with a look at the main Properties window. Select
the 'Properties' item from the 'Start > Explore > Properties'
ribbon menu.
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| Find Package |,':' ==

Element Properties ~ # x

o =-
oo
4 General
Mame Actor B
Type Actor
Stereotype
Alias
Keywords
Authar hibritten
4 State
Status Proposed
Complexity Easy
Version 10
Phase 10
[ Project

[+ Advanced

Element Properties | Element Notes

As you select items on the diagram or in the Project
Browser, you can see the Properties window change to
reflect the appropriate settings and current content for the
current selection. If you click on an Actor, you will see the
Actor's name and many other settings. If you select a
relationship between a Use Case and an Actor, you will see
the Properties window change to reflect this new type of
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thing (connector). If you click on blank space on the
diagram, the diagram itself will become the current selection
and the appropriate properties will be available in the
Properties window.

Note that when you select an element in a diagram and then
switch to the same element in the Project Browser, the
properties do not change as the two visual elements are
actually representations of the same single element.

You can change some element properties by editing the
selected item 1in the Properties window. Try changing an
Actor's name, Alias, Keywords or Status.

The Notes Window

A second very important window to become familiar with 1s
the Notes window. This window 1s where you will type your
descriptive text about an element's purpose and any other
relevant information necessary to fully and completely
describe that element. This is one of the most important
windows because when it comes to other people reading and
understanding your model, the Notes and descriptive text
are one of the major determinants of how useful and
expressive your model actually is.
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Find Package -

For the purpose of an example, | have
written some notes for the element
"Actor B".

Element Notes

MLIM

Select the 'Notes' item from the 'Start | Properties' ribbon
menu.

(Shortcut key 1s Ctrl+3)

Try entering some notes for different elements.
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The Responsibilities / Scenarios Window

Another major window you should learn to use is the
Responsibilities window. This is a collection of three other
windows, each one of which provides important modeling
detail.

You can access the three Responsibility windows from the
ribbon: 'Start | Explore | Properties'.

In the drop list select: 'Requirements' or 'Constraints' or
'Scenarios'.

(Shortcut key Ctrl+Shift+3)
Lets look at each in detail:

1. Firstly there is the Requirements window. This window
lets you add Requirements for an element that represent
responsibilities that particular element must satisfy. These
are sometimes referred to as 'Internal Requirements' to
distinguish them from the more general System
Requirements that can involve multiple elements.
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Overview Re ents  Scenarios Constraints

Requirement:
System One or Ent The system shall implement a security feature, that is
configurable by a system administrator.

#2*Basic Use Case Model x

ted: 307 PM modifi 23807 PM  100% x 1163 All UML

2. Secondly there 1s the Constraints window. This window
lets you enter restrictions and constraints on an element's
behavior, capability or structure. Many advanced
behavioral models use the Constraints window to specify,
in detail, how a system will function.
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3. The third tab 1s the Scenarios window. This window lets
you either enter simple text or use the Structured Scenario
editor to build detailed descriptions of how an element
will behave in a certain situation. Scenarios are most
frequently used with Use Cases, but can be used with any

element type where appropriate, to explain some aspect of
model behavior.
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There are many (many) more property windows in
Enterprise Architect that are used to describe and edit
element specifications. We have seen a few of these now,
and as you become more familiar with the tool, you should
experiment with others as the occasion arises.

Getting Help

In general, pressing F1 while the focus is in a Properties
window will activate the Help for that window and you can
read about the window's purpose and general usage.

Working with Diagrams
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Diagrams are the visual representation of the model and
provide one or more windows into the model's structure and
behavior. Learning to work with diagrams is an essential
part of modeling with Enterprise Architect. We will look at
some of the most fundamental aspects of using diagrams to
view and build models.

Basic SKkills

Open a Diagram

If you want to view or work with an existing diagram, you
can open it by double-clicking on its icon in the Project
Browser. For this short introduction, you should locate the
Basic Use Case Model diagram we created earlier and
double-click on its icon to open it. If it 1s already open 1t will
be selected and become the focus window.

Selecting and moving elements

Now that we have our diagram open, try clicking on
elements to select them. Once selected you can click and
drag to move, right-click to select actions from a context
menu, observe or work with an element's properties in the
various property windows and/or modify an element's
appearance and other visual characteristics. Note that you
can also click on connecting relationships between elements
and likewise edit and view properties, appearance and
positioning.
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The Layout Ribbon

The third Ribbon category 1s 'Layout' and it is the main
ribbon category devoted to manipulating the appearance of
diagrams. There are commands to change diagram themes,
set element appearance, align and format elements, layout
diagrams and filter diagram content. Many of these tools are
described in detail in the Help, so take the time to read up on
the tools and actions available so you can make the most of
your diagrames.

Basic Editing
Adding a Scenario diagram to a Use Case

Now that we have some familiarity with diagrams, let's add
a new one and build up a simple Sequence diagram
indicating the flow of actions and responses between an
Actor and a Use Case. First we will need to select a Use
Case in the Project Browser that will contain the new
Sequence diagram (or Interaction).

Create the Diagram

To begin with, click on 'Use Case A' in the Project Browser
to select 1it. Now, right-click on it to display a context menu
and select '"Add | Interaction | with Sequence Diagram'. Give
the new Interaction a name and click on the OK button.

Y ou should now have something similar to this image in
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your Project Browser.

G » [ » Model » Basic Use Case M

Project Browser o
FIERE =
4 [zl Model

A Basic Use Case Model
ESBasic Use Case Model
4 [JActors
% Actor A
% Actor B
% Actor C
% Actor D
% Systemn Actor E
4 [JUse Cases
4 T lUse Case A
4 [l Interaction 1
"B Interaction 1
2 Use Case B
2 Use Case E
2 Use Case D
2 Use Case C

Note that there 1s a new Interaction container with an empty
Sequence diagram. Double-click on the Sequence diagram
icon to make it the new default workspace. Now you will
have a blank diagram workspace and the Toolbox will have
changed to show elements commonly used in Sequence
diagrams. Firstly though, we will make use of our model
and place a link to the relevant Actor onto our diagram.
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In our original diagram, Use Case A had a relationship to
Actor A, so let's find Actor A in the Project Browser and
drag and drop it onto the new diagram.

In the dialog that pops up, select 'Link' as the type of
placement required and click on the OK button.

A new visual representation of Actor A is now created and
placed onto the Sequence diagram as a Lifeline.

Next, we need to add a Boundary element to represent the
system being modeled and how it will interact with our
Actor. From the toolbox, click on the Boundary icon and
then click to the right of the Actor lifeline. You should now
have a diagram that resembles this image:
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OK - we now have an Actor and a System and we want to
represent the flow of Action and Response between the two
entities. We can model this using messages between the
two.

Click back on the Actor Lifeline and look for the Quicklink
button - this 1s a small 'up arrow' located just at the right
edge of the selected element, and 1s only visible when the
element is selected.

« T Actor A System F A

///////////%///////////

Actor A
i
{from Actors)

\\\\\.\\\\\\\\\\\\.\\\\\\\\\\\\.\\\\\\‘D\\\.\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\h

\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\“‘D‘\\\\\\\\‘\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\g

> Start Page | =" *Interaction 1 x 4 b

All LML
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Now, click-and-hold on the Quicklink button, then drag
across to the System Lifeline and release. This creates a new
message 1in our model, between Actor A and System. Select
the new message on the diagram and note that the Properties
window switches to 'Connector Properties', allowing you to
edit details of the new connector. After entering a few
details for the message and clicking the Save button, your
diagram workspace should resemble this image:
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A return message can be created in similar fashion, by
clicking on System, then dragging its Quicklink button
across to the Actor A Lifeline. Select the new message on
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the diagram and fill in the details in the Connector
Properties window. In the 'Control Flow Type' section of the
Properties window, select the option 'Is Return'. Your
diagram should now display the return message, similar to
this image:

X

Actor A
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Connector Properties

Building the Model

1. Basic Skills

The Design Ribbon
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The Design ribbon groups together commands that are used
for creating and modifying model items, such as elements,
diagrams and Packages.

It provides access to a number of windows, such as the
Properties window, Features window and Responsibilities
window, as well as commands for viewing Package content
and diagram content as lists or Gantt charts.

Take a few moments now to explore the different menus and
sub-menus presented by the Design ribbon.

We will now use the Design ribbon to perform some basic
modeling tasks, such as creating a new Package and creating
a new diagram within the Package, before creating some
new elements and connectors on the diagram. In this
example, we will create a simple Class model.

Create a Package

We will create a new Package under the Model root node, so
click on the Model root node in the Project Browser then,
from the Design ribbon's 'Package' panel, choose 'Insert >
Insert a Simple Package'. The 'New Package' dialog will
open. Here, you can enter a name for your new Package and
you can choose to create a Package only, create a Package
with a diagram, or choose a model pattern to insert into the
new Package.

For this walk-through, choose 'Package Only', enter a name
for the Package, such as 'My Class Model', then click on the

(c) Sparx Systems 2018 Page 48 of 82 Created with Enterprise Architect



Guide to the Trial Edition - Guide to the Trial Edition 21 December, 2018

OK button. You should see the new Package in the Project
Browser, as a child of the Model root node.

Create a Diagram

Now, we will create a Class diagram within the new
Package.

Click on the Package in the Project Browser then, from the
Design ribbon's 'Diagram' panel, choose 'Insert'. The "New
Diagram' dialog will appear.

The default name for a diagram 1s the same name as its
parent Package; leave this as it 1s.

In the "Type' section, select from "UML Structural', and
choose the diagram type 'Class'. Click on the OK button.

The new Class diagram will appear in the Project Browser
and it will open in the main diagram workspace.

Diagram Toolbox

The Diagram Toolbox provides a palette of elements and
connectors that can be selected and dropped onto the
currently open diagram. Doing so creates a new element or
connector of the selected type within your model and
displays it on the diagram where you dropped it. The
Toolbox displays a set of elements and connectors that are
commonly used with the current diagram type and this set
changes as you open diagrams of different types.

Open the Diagram Toolbox now by clicking the 'Toolbox'
button in the 'Diagram' panel of the Design ribbon. The
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Toolbox 1s displayed on the left side of the diagram
workspace.
This 1image shows the new, empty Class diagram and, beside

it, the Diagram Toolbox showing the elements and
connectors appropriate for working with Class diagrames.
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= Part
H Port

T2 Expose Interface @Start Page |*5My Class Model x 4 b

Add elements to the diagram

Let's now use the Diagram Toolbox to add some elements to
our Class diagram.

Select the Class element in the Toolbox, then click on the
empty diagram. A new Class named 'Class1' is created in
your model and placed onto the open diagram. The Class
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name 'Class1' is applied by default. You can type a new
name into the Class on the diagram, or you can change the
name later using the element Properties window. Create a
second Class on the diagram by again selecting 'Class' in the
toolbox and dragging it onto the diagram.

Y our workspace should now resemble this image:
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To create a relationship between two elements on a diagram,
simply select a relationship type in the Diagram Toolbox,
then drag a line from one element on the diagram to another.
Most relationships are directional, so dragging a link from
Class]1 to Class2 is different to dragging a link from Class?2
to Classl.

Click on the Generalize relationship in the Diagram Toolbox
then, on the diagram, drag a line from Class2 to Class].
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The relationship that 1s created indicates that Class] is a
generalization of Class2.

< %E My Class Model. Class Diagram # - X

Class1

Class2

Use Case Model |“=My Class Model x| 4 b

021 PM 100% 731x 1134 All UML =

Add Elements Using Quicklinker

We briefly looked at the Quicklinker in Working with
Diagrams, where we created links between two elements in
the form of Interaction messages. Now we are going to use
the Quicklinker to create a new element at the same time as
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creating a new relationship from an existing element.

In the diagram '"My Class Model', click on Class]1 to select it.
The Quicklinker arrow should be visible beside the top-right
corner of Classl. Click and drag the Quicklinker arrow to
the right, releasing the mouse button in empty space on the
diagram. This action displays a pop-up menu that prompts
you to choose a relationship type, then an element type.
From the menu, choose 'Realization | Interface'.

Substitution

« T3 MyClassModel. Class Diagram LS
F Y
Create Multiple Elements...
. o W |
o Agagregation to Whole 4
" - Association g
ﬁ j AssociationClass r
Calls r
= I\ H Composition to Whole 4
Generalization r
Instantiates v
Realization ’ h Interface
Class2 Sends to 2
3
3

Template Binding

Aggregation to Part
Called by
Composition to Part

Instantiated by

* w ¥ w w

Specialization
Common 4

«  Filter to Toolbaox

Help...

All UML [

The resulting connector and element are shown here:
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2. Using Perspectives and Model Patterns

Enterprise Architect offers a wide range of different
Perspectives that cater to the many different kinds of
modeling you can perform. As mentioned earlier, a
Perspective is a constraint placed upon the user interface to
only show a particular technology or set of technologies. It
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is used to reduce complexity and help you focus on your
task.

Add a Requirements Model

We will now build a simple Requirements Model in our
project. Firstly, let's select one of the Requirements
Perspectives. From the Perspectives menu, choose
'Requirements | Requirements'.

- 0O X
& Perspective ™

n E % Home Page LML 4
& Libraries ~ Strategy d
Hflp | &) Reaister | Analysis d
J Requirements Requirements b
Decision Modeling X Design r
] Business Rule Model Business Modeling »
Dataflows Software Engineering  #
Systems Engineering  *
Database Engineering *
Enterprise Architecture *
Information Exchange #
Construction ¥
Management g
My Perspectives ]
My Ribbon Sets g
Manage ]
e |

After selecting the Requirements Perspective, the Model
Wizard 1s displayed in the main workspace area, offering
just a selection of basic Requirements model patterns.
Firstly, we should choose where in the model, this new
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content will be added. Click on the folder icon beside the
'Add To:' field at the bottom of the Model Wizard page, then
choose the Model root node and click on the OK button.
Now, let's select the pattern "Two Level Requirement
Hierarchy' and click on the Create Pattern button.

WLLISEHEETs gt Diagram  Process Guidance

Sl LS Two Level Requirement Hierarchy

One Level Requirement Hierarchy

Composite Requirement Hierarchy
Nested Requirement Hierarchy
Requirement Specification View

The Two Level Requirement Hierarchy pattern creates elements and a
diagram that allows requirements to be visualized in a hierarchy permitting
complex requirements to be decomposed into more granular ones down to
two levels.

Create Pattern(s) Add T M Customize Pattern on import I Combine with selected Package
L

ElModel Wizard x

The selected model pattern is added to our model under the
Model root node.

(c) Sparx Systems 2018 Page 56 of 82 Created with Enterprise Architect



Guide to the Trial Edition - Guide to the Trial Edition 21 December, 2018

Project Browser v R x
F1O%r &=~

Global  Context

4 (3 Model

[> [E]My Class Model

[ Basic Use Case Model

4 []Two Level Requirement Hierarchy
e Two Level Requirement Hierarchy

| Iilﬁequirements
«Functional» Requirement A

[> [ «Functional» Requirement A.1
I+ [l «Functional= Requirement A.2
[> [ «Functional» Requirement A3

Double-click on the diagram link in the Project Browser to
open the diagram in the main diagram workspace. You can
then select elements on the diagram (or in the Project
Browser) and use the element Properties window to tailor
them to your own use, by renaming them, entering
descriptions in the Notes window or setting other properties
as required.

Add a Class Model

We will now add a simple Class Model to our project,
following a procedure similar to the one we have just used.

From the Perspectives menu, choose 'UML | Structural'.
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The Model Wizard is displayed, showing the Structural
Perspective. Scroll through the list to find the Class
diagrams, then click on 'Basic Class Diagram with
Operations'. Click the folder icon beside the 'Add To:' field
and choose the Model root node as the location in which to
add the new model content. Finally, click on the Create
Pattern button to add the new model content to your project.
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The selected model pattern is added to your project; the
Packages, diagram and elements are shown in the Project
Browser.
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Double-click on the diagram link 'Basic Class Diagram with
Operation' in the Project Browser. This opens the diagram in
the main workspace. Now, we will use the Features window
to view the operations of Class A.

From the 'Explore' panel of the Start ribbon, choose the
menu item 'Properties > Features'. The Features window is
displayed; select the 'Operations' tab of this window.

Now click on Class A in the diagram (or in the Project
Browser). You will notice that as soon as Class A is
selected, the details of its operations are displayed in the
Features window. Here you can modify an existing
operation, by changing its name, its return type or even its
parameter list. When you select an operation in this list, the
Properties window switches to Operation Properties, and
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displays details of the selected operation.

You can also use the Features window to define new
operations, by simply typing a name into the list where it
says "New Operation...".

This image shows the Features window when Class A i1s
selected on the diagram and the Operation Properties
window when Operation B is selected in the Features
window.
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B cass
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We have walked you through some simple modeling
operations to give you a basic understanding of how you
might use Perspectives and Model Patterns to create model
structures that you can use as a starting point for creating
your own models.
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We have also demonstrated using the Project Browser to
navigate through the model, using the Diagram Toolbox to
add new content to your model via the diagram and using
various Properties windows to inspect and modify the
properties of various mode elements.
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Part 4 - Where to Now?

Having created a model in a repository, you might now like
to see how your work can be further supported by tailoring
the Enterprise Architect work area to your requirements.
You can also re-visit the tools you have used, and learn a
little more about them and about other tools and facilities
that are equally valuable in helping you develop and manage
your models.

Customize the Workspace

When you first open Enterprise Architect, you see the
default layout of the user interface. You can change the
layout and appearance of the interface in many, many ways,
hiding windows you don't need, organizing the dialogs you
do need in the most convenient configuration, changing the
display colors and texts, and much more, to suit your
personal preference, the area of work you are responsible for
and the tasks you perform.

The sections here show you where you can perform this
customization.

Change Visual Style

The 1llustrations of the user interface you have seen in the
guide have a particular color and appearance - or visual
style. You can change this style to one of several
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alternatives, using the 'Application Look' dialog (select the
'Start > View > Visual Style > Visual Style' ribbon option).

Application Look

Theme Dark Gray

Accent Color: Blue (Default)

Visual Appearance
Code Editor: Automatic
Diagram: Use current theme -
Waorkspace Left -

Default Note Zoom: -

Window Styles

B Show Menu Icons

Main View Tabs use Caption style

Main View Tabs at bottom (restart)
Property Sheets use Tree style

M Use Property List for Elements

B Frefer Property dialogs

M Increase Note Paragraph Spacing

ECE TTE T T

The first three fields on the dialog have the greatest visual
impact. Try experimenting with changing the values; you
can click on the Apply button and see the effect without
having to close the dialog. Note that for some of the

permutations you do not need to have values in all three
fields.

The default values are shown in the illustration, so you can
return to them if you need to!
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Set Some Major Preferences

Preferences are aspects of the system that you personalize so
that every project you open in Enterprise Architect, on your
workstation and under your user ID, looks and behaves in
the same way - the way you want them to! Each user might
see the same project differently, according to their own
preferences.

You start by displaying the 'Preferences' dialog (select the
'Start > View > Preferences' ribbon option).

General

[ Window Behavior

4 [1Diagram s -
D%hemes Author: Javid Steele - Clipboard Format:

1 Gradients and Background .

% Standard Colors M Use |ET 4.0 - requires restart Use extended << and == characters
3 Appearance
1 Behavior
IT—ESe{qu:er'l.ce

a, .
gy Links
> XML Specifications
4 @ Source Code Engineering Web Home: http:/fsparxsystems.com
Code Editors
@, Artribute/Operations
ActionScript Web Mail:

M Allow custom RTF tags in reports

Web Search: www.google.com

Portal Guides:

ree Sorting
Show Sterectypes

Project Loading Strategy: Load on Demand (Lazy Load) -

Server connections use the option set when creating the connection

As you can see there are many pages of options you can set,
although not all options will be important to you. Click on
the page names on the left of the dialog to review the
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options that are available. If you want an explanation of a
setting, click on the Help button to display a description of
every setting on the page.

The most visible preferences are the object colors on
diagrams. Open a diagram and then change the settings on
the 'Diagram > Standard Colors' page of the dialog. Every
setting has an option to revert to the default color, so you
can try all sorts of combinations without losing the standard
settings.

Customize Ribbon Categories

The ribbons at the top of the work area together provide
access to almost every tool and facility of Enterprise
Architect, but as you are unlikely to use every tool and
facility you might consider tailoring the ribbons to exclude
things you do not need. You first display the 'My Ribbon
Sets' tab of the 'Workspace Layout' dialog (select the 'Start >
View > Workspace > My Workspaces' ribbon option and
click on the "My Ribbon Sets' tab).
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LTy ST L R L E T My Ribbon Sets

Configure Ribbons:

Marme

Click on the New button and type in a name for your custom
ribbon display. You will see that all the ribbons are now
listed in the 'Configure Ribbons' panel, and if you expand a
ribbon name the sections of that ribbon are also shown. For
every ribbon and section that you don't need, you clear the
selected checkbox so that the ribbon or section will be
excluded from the ribbon bar.

Click on the Apply button to update the ribbon display. If
you want to reinstate the default full ribbon set, click on the
background of the 'Create Ribbon Set' panel and click on the
Reset button.

Putting Things in their Place

When you open Enterprise Architect for the first time, the
various windows are in position around the display. These
windows - and others that you open - do not have to stay in
those positions, you can simply click on the window name
and drag the window to a more convenient spot on the
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display.
Alternatively, you can dock a window exactly where you
put it, so it stays there, open, across many work sessions.

As you move a window, a 'compass' icon displays in the
center of the screen and a 'compass point' icon displays on
cach edge.

When you move the window over a compass point, an area
of the display turns blue. This is the area that the window
will occupy when you drop and dock it. You can then adjust
the window borders to suit.

If there is another window in the docking area another
compass displays there, with a square in the middle. The
compass points dock the dragged window above, below, or
to the side of the other current window, whilst the square
makes it a tab of the same frame as that window.

Using the Workspace facilities

Docking a window puts one window 1n position at a time,
but many of the windows can be used in combination, so to
save you from working out, building and positioning those
combinations, the system provides them for you and gives
you the tools to quickly apply them! These tools form the
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Workspaces facility (select the 'Start > View > Workspace >
Select a Workspace' ribbon option).

Workspace Layout
L g sl My Workspaces My Ribbon Sets

Available Workspaces

Basic Diagramming
g4 System Collaborate
g4 System Core Modeling

gd System Explore

dd system Wide View

dd system Database modeling

dd system Gap Analysis

dd system Requirements

0d system Schema Design
System Trace by Matrix
System Use Case modeling
System Code Editing
System Debug
System Profile
System Record
System Software Engineering
System BPSim
System DMMN-Sim

Close on Apply

Last Applied Workspace:

M Load Workspace on Startup

Before you try out some layouts, clear the 'Close on Apply’
checkbox, so that you can try different layouts without
having to re-open the dialog. Select a layout (such as
'Debug') and click on the Apply button.

You can set a system-defined layout and then move
individual windows, or otherwise create a layout that better
suits you. Having done that, you can save it as a personal
layout by selecting the 'Start > View > Workspace > Save
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Current Window Layout' ribbon option, which prompts you
to give your layout a name. If you use some other layout
you can come back to yours by selecting it on the 'My
Workspaces' tab of the "Workspace Layout' dialog.

Workspace Layout
Workspaces BEVALEGWETL=SS My Ribbon Sets

Available Workspaces

Last Applied Workspace:

M Load Workspace on Startup

Going Back to Work

You do a lot of work using windows such as the Diagram
View (with several diagrams as tabs, perhaps), Relationship
Matrix and Model Search.

Having reached the end of a work session, you might want
to start your next work session by picking up where you left

(c) Sparx Systems 2018 Page 70 of 82 Created with Enterprise Architect



Guide to the Trial Edition - Guide to the Trial Edition 21 December, 2018

off. You can capture your current work status using the
Working Sets window (select the 'Start > View >
Workspace > My Working Sets' ribbon option).

EHE e | X ©
Warking Sets

5 My Qass Model
P4 Interaction 1

X

Create Working Set

VEa myWorkingSet

Open Windows

| Marme
T3 My Qass Model
P Interaction 1

EE Include &l § Include None

Y ou right-click on the central panel of the 'Manage Working
Sets' dialog and select the 'Store Main Tab View History'
option, which captures the views that you have open as you
close down your work station. If you also select the 'Apply
When Model Opens' option, the system will automatically
open those views when you open your model in the next
work session. Alternatively, you could use the 'Open
Working Set' option when you are ready to resume that
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work, 1f you need to do something else st

Quick Reference

Ribbons in Brief

Ribbons, shown at the top of the work area, provide access
to almost every tool and facility in Enterprise Architect.
Each ribbon supports a domain of work - such as designing
the model components and structure - and is divided into
segments to group the tools and facilities according to the
structure or function the tools support.

I Start Desi Simulate ode cute onfigure Speci @ Find Commane
% a4 Full Screen = - =1 My Kanban @ Home Page
=F 2" = w e R = .

4 Visual Style ~ [ My Gantt & Libraries ~
Browse Properties Trace Search Perspective Workspace Preferences Discussions Reviews Team Mail Calendar M Help
- - - - - - - - Libra -

i 581 Register
Explore View Collaborate Help

This example is the Start ribbon, which provides access to
tools for organizing your work and your work area. In
particular, look at the options in the 'Explore' panel, which
provides the tools for seeing what 1s in your model and
where particular objects are. These tools include:

. Browsers - such as the Project Browser, Element Browser
or Resources window

. Properties displays - such as the Properties window itself
and windows showing Notes, related Documents, Features
and Constraints
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. The Trace facilities for examining and tracing
relationships between pairs of elements and sequences of
elements

. The model Search, providing many predefined searches
for locating and highlighting different objects in your
models

Portals Window

The Portals Window displays one of nine Portals, and
provides the facility for switching to a different Portal. The
Portals identify tasks in particular areas of work, and
provide links to the window or dialog for performing each
task. The Guidebook and Learning Portals provide links to
online information that describes a feature of Enterprise
Architect and how to work with it. You display the Portals
window by selecting the 'Show > Portals' option at the left
end of the ribbon bar.
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L ] ]
Insert Ed

- -

Perspective
Workspace
Window
Status
Extend
Execute
Revisit

v Guidebook

Learning

Show Toolbar *

Perspectives

Portals

= Guidebook -

[

[

|

-]
-]
]
]
-]
-]
]
]
-]
-]
]
]

Basics
Repository
Modeling

Building Models
Modeling Perspectives
Model Wizard
Workspace Layouts
Model Mavigation
Specification Manager
Metamodels
Requirement Models
Schema Models
Team Support

Team Library

Journal

Model Transformation
Model Validation
Time Aware Models
MDG Technologies

Domains

Guides

Project Management
Publishing
Simulation
Execution

Automation

21 December, 2018

Perspectives refine the model development facilities in
Enterprise Architect to support a particular technology or
domain, The most visible effects of setting a Perspective are
that the contents of the Diagram Toolbox are restricted to
those element and connector sets used in the domain, and
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the model Patterns are tailored to generate diagram and/or
model structures of exactly the type for modeling in your
selected area.

You can list and select the Perspectives from the
'Perspective’ drop-down list in the top right of the display.

- O x
® Perspective 7

All UML uML

h‘ Structural Strategy

Behavioral Analysis

Requirements

Find Pacl i

Business Modeling

-

Software Engineering
Systems Engineering
Database Engineering
Enterprise Architecture
Information Exchange

Construction

* T w v w w v w v v w v ¥

Management

-

My Perspectives
My Ribbon Sets r

Manage r

Element Pmperties| MNotes

Collaboration

If you are working as a member of a team, you will need to
contact colleagues with anything from a quick question to a
list of formal review comments. Whichever type of message
you want to send, Enterprise Architect has a facility to
create and deliver that message.
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You can access the facilities through the 'Start >
Collaborate' ribbon segment, selecting the 'Discussions’,
'Reviews' or 'Mail' options. The Discussions option gives
you a Chat facility too.

2 i (2 &)

Discussions Reviews Team Mail Calendar
h - Library

Collaborate

(Note that the Mail and Chat facilities operate on user IDs,
which cannot be set in the Trial edition. The windows
display, but you cannot send a message.)

Shortcut Keys

Many of the facilities and operations in Enterprise Architect
can be selected by pressing keyboard keys as well as by
selecting ribbon or menu options.

For a list of the keyboard shortcuts you can use, access the
Learning Portal (select the 'Show > Portals > Learning'
ribbon option) and look at the Keyboard Shortcuts and
Diagram Shortcuts topics under the 'Quick Reference'
heading.

Resources You Can Use

Help
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At any time, if you want information on the purpose of a
screen or how to complete it, you can select one of these
options to display the Help topic describing that screen:

. Press Fl
. Click on the @ icon 1n the screen header, or
. Click on the Help button at the bottom of the screen

Or you can access the Help by selecting the 'Start > Help >
Help > Open Help System' ribbon option.

Each Help topic displays as a web page. You can click on
the list of topics on the left of the page to explore related
and/or more detailed topics, or click on a point in the
'breadcrumb’ trail above the topic to access more conceptual
topics or Help on a different subject area.

SIrrPARX

Index User Interface The Enterprise Architect Ribbons Start Ribbon

Start Ribbon

The 'Start' ribbon provides a range of facilities for exploring, navigating and viewing the
_ navigate and search for items, to view the important events, messages, discussions anc
=l View Panel view and change your workspace settings, including styles and preferences. This ribbon
registering licence keys and checking for updates.

El Explore Panel

El collaborate Panel

El Help Panel

The Example Model (EAExample)

The Example model 1s a collection of model fragments,
brought together into a single model, to illustrate the many
different ways to use Enterprise Architect across a broad
range of model domains. The Example model does not
represent a model of a working system, instead it provides
samples from many disparate systems.
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The example model is provided as part of the Enterprise
Architect product installation and you can open it from the
'Help' panel of the 'Start' ribbon, selecting 'Help | Open the
Example Model'.

When you load the EAExample model, its default diagram
'Getting Started' is loaded. The 'Getting Started' diagram
contains a series of links to other diagrams that relate to
different modeling domains, such as Business Modeling or
Systems Modeling, as well as some of the tasks you might
want to perform in Enterprise Architect, such as Project
Management and Publishing. Double-clicking on a diagram
link will open the diagram. The next level of diagrams
typically contain a description and some instructions on how
to access related features in Enterprise Architect, and further
links to model examples for that area of interest.
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» Bs Ig Getting Started. Custom Diagram € - x
Getting Started
Basic Modeling \@ Business Modeling '\@ Software Modeling \@ Systems Modeling \@
X e _l B=H
i \ @ B B8 =
o o gt N
Database Modeling @E/ Enterprise @E’ Requirements Model@_‘%« Simulation @E/
Architecture
= o "
B [ ’: E j L L |I:
—= = 3
— amlan N
- = N -
Schema Modeling \?E/ Geospatial Modeling\?ﬁ/ Project Management\_%_a/ Publishing \?E/
= = :El I
80 80 Y Eﬁ
Profile Extensions @:@ Pro Cloud Server \@
— Do
L =

@Start Page | = Getting Started x | BeRequirements Model

: Requirements Model Decision Modeling -] NUM

As an example, try double-clicking on 'Requirements
Model' in the 'Getting Started' diagram, then 'Tracing
Requirements' on the next diagram. and finally "Traceability
Diagrams' on the diagram with the heading 'Traceability'.
This will bring you to an example of a Traceability
Diagram.
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> ?Eﬂ Traceability Diagram. Class Diagram €« v x

Traceability Diagram

A number of tools are available for updating diagrams to show The command 'Insert Related Elements' can be accessed either from the
traceability: Design ribbon by choosing the option 'Element > Insert Related', or by

- On a diagram, right-click an element and choose: 'Insert Related right-clicking the element of interest on your diagram and choosing
Elements' to automatically add elements that are linked to the selected 'Insert Related Elements' from the context menu.

element

- On the Relationships window, use the context menu option 'Place 1
i P Insert Related .

Elements
-image

Related Element in Diagram' to add elements to the diagram that are
directly linked to the selected element
- On the Traceability Window, add elements that are indirectly linked

This diagram was created using the 'Insert Related Elements' command.

The element 'REQD11 - Manage User Accounts' was manually placed on
the diagram, then all other elements were added automatically using the
'Insert Related Elements' command.

(from Manage Users) h

(from Manage Users)

_{ H REQO16-Add Users |- ____ _ Create Account
=realizes (==
{from Manage Uisers)
! Y‘

l H REQO11 - Manage User Accounts l

{from Maf, jge Usm<> arealizes
S Delete User
=7 ===}
-

z
(from Manage Users)
H REQU17 - Remove User l

I
aincludes

Abstract Class Model::Account

BPM 100% 938x 655

You will find a description of what is on the Traceability
Diagram, why it is useful and how to create one for
yourself. You can right-click on the diagram 1itself - or its
clements - and 'Find' them in the Project Browser to see
where the elements come from and how they relate to each
other.

Webinars and Video Resources

Sparx Systems has published a number of web seminars,
tutorials and video demonstrations of the use of Enterprise
Architect tools and facilities, on our website. These
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recordings are often quite short and all are easy to watch.

You can access the recordings through the Learning Portal
(select the 'Show > Portals > Learning' ribbon option) by
clicking on the 'Resources' option under the 'About' heading.
This displays the 'Resources & Tutorials' web page, which
provides three separate icons for the webinars,
demonstration videos and tutorials.

Guidebooks

For a more in-depth discussion of Enterprise Architect's
support for an area of work, you can read one of the many
PDF Guidebooks held in the Sparx Systems online library.
You can access these through the Guidebook Portal (as you
saw 1n the 'Portals' section earlier).

You can either read a guidebook online or print it.
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